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The world is being transformed by a few mega forces. In Europe, geopolitical  
fragmentation is creating a renewed sense of urgency to address structural 
challenges that have stunted growth for years. We see the direction of travel 
as positive enough to close some of the long-run performance gap between 
U.S. and European equities, but more is needed for a broad renaissance. Yet 
we see bright spots: in financials, infrastructure and now also healthcare. We 
keep our country preference for Spain. We think the region’s broad economic 
stability is favorable for fixed income assets, especially in credit, which we 
generally favor over exposure in other geographies. 

While big tech’s AI buildout is the distinctive 

feature of the U.S. economy right now, 

Europe is mostly focusing on ways to unlock 

reforms that can boost growth that has been 

mediocre for over a decade. We have already 

seen some real policy action, for example the 

2024 revision of the Stability and Growth 

Pact (SGP) that makes EU fiscal policy more 

flexible. Fiscal adjustment plans can now 

extend from four years to seven if linked to 

structural reforms – an innovation that could 

give governments more room to pursue 

strategic objectives. We see policymakers 

focusing their actions on three key priorities:

Defense spending. As well as more flexibility 

in the SGP, countries can now temporarily 

deviate from budget rules to fund defense. 

As of 2025, Member States can run 

additional deficits of up to 1.5% of GDP a 

year through 2028, specifically for military 

spending. Indeed, 16 EU countries (including 

all major economies) have done so. It is no 

coincidence that the cap of 1.5% matches 

the gap between current EU military outlays 

and NATO’s 3.5% of GDP target for 2035. 

Energy policy. Industrial electricity prices 

are roughly double those in the U.S. and 

China. High energy costs and dependence 

on imports reduce Europe’s competitiveness 

and leave it vulnerable to external shocks. 

The European Commission’s comprehensive 

Affordable Energy Action Plan aims to 

improve competition in energy supply and 

drastically shorten permitting timelines for 

new clean power projects and energy 

infrastructure. Alongside the relaxed fiscal 

rules (that also facilitate green investments), 

these measures seek to lower power prices 

and make the bloc more energy independent. 

Mobilizing savings. Europeans are big 

savers, but much of that money – about €14 

trillion – sits in low-yielding bank deposits. 

While key milestones (like a full banking 

union) seem out of reach for now, we think 

tangible progress can be made in improving 

Europe’s attractiveness as an investment 

destination and in channeling more savings 

into productive investments. That could 

create a positive feedback loop: more wealth 

spurs more consumer spending, thus 

boosting growth. 

Multiple micro-level reforms will also be 

needed to boost Europe’s competitiveness. 

Some progress is being made here, too. 

Former ECB President Mario Draghi’s report 

on EU competitiveness set out 383 reform 

recommendations. One year on, about 11% 

of those proposals have been fully 

implemented and 20% more are at least 

partially achieved, an EPIC report shows. 
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This policy action has supported 

European markets in 2025 and, 

looking ahead, we think it could 

close much of the performance gap 

between European and U.S. stocks 

over the last 15 year (of 8.6% per 

annum, MSCI data show). But is 

still not enough to drive sustained 

European outperformance. More 

needs to be done to improve the 

return on invested capital for 

European firms, especially versus 

the U.S. The small outperformance 

in 2025 was mostly driven by an 

expansion of multiples rather than 

earnings growth. Still, LSEG data 

shows that every European sector 

trades at a discount to its U.S. 

equivalent. That opens the door to 

select opportunities. 

We still like financials. Balance 

sheets, especially of large banks, 

are healthy, profitability is high, we 

are likely past “peak regulation”, 

and AI could drive cost savings. The 

sector is also likely to be the 

conduit of rising public spending 

on defense and infrastructure and, 

as the main provider of retail 

investment products in Europe, the 

nexus for turning European savers 

into investors.

We also reaffirm our positive view 

on utilities and infrastructure. We 

see the political focus on energy as 

a major positive near-term driver 

for European utilities, especially 

those with sizeable exposure to 

power grid/network operators.

We switch our tactical preference for 

industrials to healthcare: the sector 

trades at a discount versus its 10-

year history (unlike the broad 

market), free cash flow generation is 

second only to IT, and we see it as a 

potential early beneficiary of AI. 

Our preferred country remains 

Spain. Domestic fundamentals are 

strong, valuation and earnings 

momentum are still favorable versus 

peers, and our preferred sectors are 

also well represented in Spain. 

In fixed income, we generally prefer 

Europe to elsewhere. Europe’s 

economic governance makes it hard 

to run persistently high budget 

deficits, even with now more flexible 

fiscal policy. Europe’s starting point 

(in both deficit and debt) is stronger 

than in many other major markets. 

We think this should translate into 

less upward pressure on term 

premium than in the U.S. and Japan.  

We also reaffirm our long-held 

preference for European credit 

exposure, which has worked well so 

far. European AI capex is set to be far 

outstripped by the U.S., likely 

limiting the amount of re-leveraging 

in the private sector. Euro high yield, 

is trading closing to historically low 

spreads, but will likely be supported 

by somewhat better economic and 

earnings growth next year and still 

muted credit losses.

We hope you find this a helpful read 

and wish you all the best for 2026! 
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2026 Global Outlook

Introduction

Twice a year, BlackRock’s senior portfolio managers and investment executives gather for two days to debate the outlook for the global 

economy and markets – and its implications for portfolios. The Global Outlook is the culmination of that debate and discussion at our 

latest Forum and informs our macro framing. What has become clear this year: our mega forces framework, launched a few years ago, is 

a critical way of understanding these drivers of economic transformation and the investment opportunities they create. This Outlook is 

centered in reconciling the clashing orders of magnitude on investment and potential revenues in the AI buildout – and how it is 

intersecting with other mega forces, such as the energy transition and future of finance.
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Summary

The global economy and financial markets are being transformed by mega 
forces, especially AI. Technology is becoming capital-intensive, and the AI 
buildout could be unprecedented in both speed and scale. With a few mega 
forces driving markets, it is hard to avoid making a big call on their direction – 
and as such, there is no neutral stance, not even exposure to broad indexes. We 
remain pro-risk and see the AI theme still the main driver of U.S. equities. Yet this 
environment is ripe for active investing – picking winners and losers from among 
the builders now and later as AI gains start to spread, in our view.
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Diversification mirage
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We’ve long argued we’re in a world of structural 

transformation shaped by a few mega forces, 

including geopolitical fragmentation, the future 

of finance and the energy transition. But the most 

obvious now is AI, with a buildout of a potentially 

unprecedented speed and scale. This shift to 

capital-intensive growth from capital-light is 

profoundly changing the investment environment 

and pushing limits on multiple fronts – physical, 

financial and socio-political. 

A few big macro drivers implies a few big market 

drivers. Today’s market concentration reflects 

underlying economic concentration. That means 

investors can’t avoid making big calls, in our view. 

AI is the dominant mega force right now, helping 

propel U.S. stocks to all-time highs this year. In 

recent months, investors have started to fret 

about equity valuations and whether an AI bubble 

is forming. The Shiller price-to-earnings ratio 

shows U.S. stock valuations are the most 

expensive since the dot-com and 1929 bubbles. 

Market bubbles have arisen in all major historical 

transformations – and that could happen again. 

But those bubbles also grew for some time and 

only became obvious after they burst. That’s why 

we seek to reconcile the potential orders of 

magnitude of investment and revenues. That’s 

our basis for tracking the AI transformation and is 

what we do in this Outlook.

The capital spending ambitions tied to the AI 

buildout are so large that the micro is macro – our 

first theme. The overall revenues could justify the 

spend – yet it’s unclear how much will accrue to 

the tech companies building AI. That’s why they 

are not on autopilot and could adjust plans with 

greater visibility on revenues and as stark energy 

constraints bite. The latter could slow the buildout 

but create other opportunities. We stay pro-risk 

and overweight U.S. stocks on the AI theme. This 

is a great time for active investing for those with 

insights on who will capture the revenues.

The AI builders are leveraging up, our second 

theme. We think that is needed: The spending is 

front-loaded – and unavoidable to realize the 

benefits – while revenues are back-loaded. Along 

with highly indebted governments, this creates a 

more levered financial system vulnerable to 

shocks – including bond yield spikes tied to policy 

tensions between inflation and debt 

sustainability. We see private credit and 

infrastructure supporting this financing. We go 

underweight long-term U.S. Treasuries tactically. 

This environment also creates a diversification 

mirage, our third theme. Allocations made under 

the guise of diversification may now in fact be big 

active bets. We think portfolios instead require a 

clear plan B and a readiness to pivot quickly. We 

prefer idiosyncratic exposures in private markets.

Contents
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Investment environment

Clashing orders 
of magnitude
The AI buildout could be faster and 

greater than all past technological 

revolutions. See the chart. External 

estimates of AI corporate capital 

spending ambitions range between 

U.S.$5-8 trillion globally through 

2030, most of that in the U.S. The 

challenge for investors: reconciling 

the huge capital spending plans 

with the potential AI revenues. Will 

their orders of magnitude match? 

Based on the highest end of the 

spending range, the answer 

depends on whether U.S. growth 

can break out from its long-term 

2% trend. This is a tall order, but AI 

makes it conceivable for the first 

time. See next page. Even if 

spending and revenues reconcile at 

the macro level, there is still a 

timing mismatch. The AI buildout 

requires front-loaded investment: 

compute, data centers and energy 

infrastructure. The eventual 

revenue from that investment 

comes later. The buildout is just 

starting and concentrated in the 

tech sector, for now, but we see 

productivity and revenue gains 

spreading across the economy. 

The gap in time between capex 

needs and eventual revenues means 

AI builders have started using debt 

to get over a financing “hump.” This 

frontloading of spending is 

necessary to realize eventual gains. 

Private sector leverage will add to a 

heavily indebted public sector, 

creating financial system 

vulnerabilities. Bond yield spikes 

could pose a risk to this financing. 

All this creates a very different 

investment environment with some 

core features. First, higher leverage 

will result in greater credit issuance 

across public and private markets. 

Second, a broadly higher cost of 

capital as this big borrowing puts 

upward pressure on interest rates. 

Third, before new pools of AI 

revenues spread across the 

economy, further concentrated 

market gains within tech will require 

big calls. And fourth, more room for 

alpha and active investing as those 

revenues spread beyond tech. All 

this means traditional approaches to 

portfolio construction need a 

rethink.

Forward-looking estimates may not come to pass. Source: BlackRock Investment Institute with data from 
Crafts (2021), December 2025. Notes: The chart shows the average annual contribution of capital spending 
to GDP growth for previous U.S. technologies (except “steam,” for the UK) against the length of time the 
capital was spent. Estimates for steam, electricity and ICT are taken from Crafts (2021). The spend needed for 
artificial intelligence (AI) is calculated using realized capital spending between 2022-2024, the upper end of 
the U.S.$5-8 trillion range of total capital spending intentions spanning the period 2025-2030, and an 
assumption that capex intensity continues at a similar rate through 2030-2040.

A rapid transformation
Length and capital deepening of notable innovations, 1760-2040

This investment environment has some 
core features: higher leverage, a higher 
cost of capital, concentrated gains 
requiring the need to make big calls, and 
more opportunities for active views.

Chart takeaway: Getting inflation all the way back down to 
target – the dotted green line – would require the Fed to deal 
a significant blow to the economy.
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Chart takeaway: The AI transformation is unfolding fast and is 
driving record investment — we could reach a level close to the 
largest buildout in half the time.
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Investment environment

Growth breakout: 
now conceivable
We see AI capital spending still 

supporting growth in 2026, with  

the contribution to U.S. growth 

from investment totaling three 

times its historical average this 

year. This capital-intensive boost is 

likely to persist into next year, 

allowing growth to hold up even as 

the labor market keeps cooling. 

This “no hiring, no firing” stasis 

gives the Federal Reserve room to 

keep trimming policy rates in 2026. 

Yet inflation could prove sticky 

above the Fed’s 2% target. We see 

a favorable policy and regulatory 

backdrop heading into the U.S. 

midterm elections. Any rebound in 

business confidence and hiring 

could reignite inflation, bringing 

back policy tensions with debt 

sustainability. 

Zooming out, AI will likely keep 

trumping tariffs and traditional 

macro drivers as it has in 2025. In a 

world where U.S. trend growth 

stays under 2%, absorbing that 

capex will require big macro 

adjustments – crowding out other 

non-AI spending in the economy, 

and potentially resulting in much 

higher inflation. 

But the big question is whether it’s 

possible for U.S. growth to eventually 

break out of its long-term trend. The 

U.S. sits at the global economic 

frontier. But all major innovations of 

the last 150 years – including steam, 

electricity and the digital revolution 

– were not enough for it to break out 

of its 2% growth trend. Doing so is a 

tall order. 

Yet it is conceivable for the first time. 

Why? AI is not only an innovation 

itself but has the potential to 

innovate the process of innovation. 

AI could begin to generate, test and 

improve new concepts on its own. If 

that happens, the rate of discovery 

could accelerate, driving scientific 

breakthroughs such as in materials, 

drugs and technology. This self-

reinforcing loop of accelerating 

innovation is key to achieving the 

breakout. 

While conceivable, we don’t know if it 

will happen. We track evidence that 

can serve as a leading indicator of 

faster innovation – for example, a 

surge in the number of new patents 

each year – before any benefits start 

to show up in broader activity data.

Source: BlackRock Investment Institute, Bureau of Economic Analysis and Macrohistory Database, with data 
from Haver Analytics, December 2025. Note: Historical data compiled by Òscar Jordà, Moritz Schularick, and 
Alan M. Taylor. 2017. Macrofinancial History and the New Business Cycle Facts. in NBER Macroeconomics 
Annual 2016, volume 31, edited by Martin Eichenbaum and Jonathan A. Parker. Chicago: University of 
Chicago Press.

Never broken out
U.S. GDP per capita and long-term trend, 1870-2024

For the U.S. to break out of a 2% growth 
trend, it will require innovation in how 
we innovate - and that first requires 
massive upfront investment.

Chart takeaway: Getting inflation all the way back down to 
target – the dotted green line – would require the Fed to deal 
a significant blow to the economy.

Chart takeaway: Over the past 150 years, U.S. growth has stayed 
remarkably close to a 2% trend even with past technological 
revolutions. We think it’s conceivable that accelerating AI-driven 
innovation could boost growth above that trend.
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Theme 1

Micro is macro
The AI buildout is dominated by a 

handful of companies whose 

spending is so large that it has a 

macro impact. Taking a view on 

these companies requires assessing 

whether the macro math adds up. 

Take the upper end of the range of AI 

investment ambitions through 2030 

of $8 trillion. See page 6. Broker 

analysts see total annual 

hyperscaler revenue increasing by 

$1.6 trillion. That would fall short of 

the revenues needed to deliver a 

reasonable rate of return of 9-12% 

on that upper-end of AI investment. 

See the chart. But that’s not the full 

picture: the true potential of AI goes 

beyond existing business lines. As AI 

becomes embedded in the economy, 

we expect it to create entirely new 

pools of revenue in the tech sector 

and beyond. Where exactly is highly 

uncertain. But we can still try to 

gauge the macro size.

To do that, suppose we break out of 

a 2% growth world and AI delivers a 

1.5% boost to growth through 

productivity gains. We estimate that 

this would expand economy-wide 

revenues by $1.1 trillion per year – 

more than enough to justify the 

upper-end of spending. 

But even if the numbers might add 

up at the macro level, there is no 

guarantee those revenues will flow 

to the AI builders. If the tech sector 

grows its share of revenue from 25% 

now, LSEG data show, to 35%, that’s 

a $400 billion boost. See the right 

bar. Combining these new revenues 

with current analyst estimates 

suggests this could deliver a 

reasonable return on investment.

We see room for tech revenues to 

move in that direction as current AI 

builders eat into parts of the tech 

ecosystem, like software. AI’s ability 

to automate tasks, such as coding, 

means it could replace other tech 

services. Yet revenue gains will 

increasingly spread across sectors 

and the economy. Entirely new AI-

created revenue streams are likely to 

develop. How those revenues are 

shared is likely to evolve – and we 

don’t yet know how. Finding winners 

will be an active investment story. 

We stay overweight U.S. stocks and 

the AI theme, supported by robust 

earnings expectations. The capex 

may pay off overall even if not for 

individual companies. The next 

phase may be more about energy 

and resolving bottlenecks.

Chart takeaway: Getting inflation all the way back down to 
target – the dotted green line – would require the Fed to deal 
a significant blow to the economy.

Forward-looking estimates may not come to pass. Source: BlackRock Investment Institute, Bloomberg and 
others, December 2025. Notes: The left bar shows the necessary incremental revenues to be achieved 2025-
2030 to reach a 9-12% lifetime internal rate of return. This is based on data center deployment estimates 
(gigawatt terms) and capex per gigawatt assumptions reflecting cost inflation, GPU life, phasing and 
hyperscaler market share. We cross-referenced with other sources including McKinsey & Company, Boston 
Consulting Group, Lawrence Berkeley National Laboratory, International Energy Agency, U.S. Department of 
Energy, BloombergNEF, Schneider Electric, Electric Power Research Institute and others. These calculations 
include retail revenue growth (Amazon) and other non-data center revenues according to Bloomberg 
consensus estimates. The right bar shows the Bloomberg consensus for the increase in annual revenues over 
2025-2030 for U.S. hyperscalers including Microsoft, Meta and Google.

Doing the math
Estimates of annual U.S. corporate revenue growth through 2030

Chart takeaway: We find that large tech firms will need to grow 
revenue faster for AI-driven investment to pay off.

Investment implications 
• We stay risk-on and overweight U.S. stocks on 

the AI theme. 

• We believe the AI theme will become an active 
investment story of identifying new winners as 
AI revenues spread across the economy.
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Theme 2

Leveraging up
Getting over the AI buildout’s 

financing hump between front-

loaded investment and back-loaded 

revenues needs long-term financing. 

That means greater leverage is 

inevitable. This has already started 

as seen from recent bond sales from 

large tech firms. 

The good news: the starting point for 

private sector leverage is healthy, 

particularly listed tech. The largest 

cloud spenders sport an average 

debt-to-equity ratio of 0.54 times as 

of Nov. 26, Bloomberg data show, 

pointing to room to lever up. New 

issuance from major tech firms has 

so far been well received by markets.

The financing needs tied to AI capex 

far exceed what even the largest 

firms can meet internally. But this is 

occurring against a backdrop of 

already highly leveraged public 

sector balance sheets. See the chart. 

Elevated debt and competing fiscal 

priorities - from Germany’s defense 

push, stretched U.S. and UK budget 

deficits and Japan’s new spending 

pledges – limit the public sector’s 

role in financing the AI buildout.

That’s why we expect companies to 

keep tapping public and private 

credit markets, creating 

opportunities for investors. 

Higher borrowing across public and 

private sectors is likely to keep 

upward pressure on interest rates. 

Elevated debt servicing costs are 

one reason we see term premium – 

or compensation investors demand 

to hold long-term bonds – rising and 

pushing up yields. We turn 

underweight long-term Treasuries. 

AI could eventually deliver the 

productivity gains needed to ease 

public debt burdens, yet that will 

take time. 

One risk: a structurally higher cost of 

capital raises the cost of AI-related 

investment and affects the broader 

economy. A more leveraged system 

also creates vulnerabilities to shocks 

such as bond yield spikes tied to 

fiscal concerns or policy tensions 

between managing inflation and 

debt servicing costs. Indebted 

governments have less capacity to 

cushion such shocks. This is where 

AI financing needs and government 

debt constraints intersect. 

Chart takeaway: Getting inflation all the way back down to 
target – the dotted green line – would require the Fed to deal 
a significant blow to the economy.

Source: BlackRock Investment Institute, Congressional Budget Office, Bureau of Economic Analysis, Federal 
Reserve Board, with data from Haver Analytics and LSEG Datastream, December 2025. Notes: The chart 
shows U.S. federal debt as a share of nominal GDP, and debt of U.S. nonfinancial corporations as a share of 
pre-tax profits.

Debt divergence
U.S. government and corporate debt, 1950-2025

Chart takeaway: Public and private balance sheets have 
diverged sharply: government debt has surged to postwar highs 
while corporate leverage has eased. This is why the corporate 
sector has room to leverage up to fund the AI buildout.

Investment implications 
• We see rising AI exposure in public and private 

credit markets. 

• We go tactically underweight long-term 
Treasuries as we see investors demanding 
more term premium.

0x

4x

8x

12x

16x

20x

24x

0%

20%

40%

60%

80%

100%

120%

1950 1960 1970 1980 1990 2000 2010 2020

D
e

b
t-to

-p
ro

fit ra
tio

S
h

a
re

 o
f 

G
D

P

U.S. government debt

Corporate debt ex. financials (right)

CAPITAL AT RISK. INVESTMENTS CAN RISE OR FALL IN VALUE. FOR PUBLIC DISTRIBUTION IN THE U.S., CANADA, LATIN AMERICA, ​ SELECT COUNTRIES IN EUROPE (SEE THE FULL DISCLAIMER), ISRAEL, SOUTH AFRICA, HONG KONG, 
SINGAPORE AND AUSTRALIA. ​FOR INSTITUTIONAL, PROFESSIONAL, AND QUALIFIED INVESTORS AND CLIENTS IN OTHER PERMITTED COUNTRIES.

BIIM1225U/M-5031110-9/20



Guides

Go to View and check the “Guides” box to see page margins 
and columns. This feature will help align items on the page.  

Text

Adjust text sizes as needed. Bigger is better. Use only 
BLACK or WHITE text. Use font size and/or the Extrabold, 
Bold, or Body font weights instead of color to differentiate.

Body copy (minimum 9pt BLK Fort  

Line Spacing Multiple 1.13

After Spacing 6pt) 

Use Increase List Level tools in text placeholders to adjust 
the text formatting as listed in the reference below:

Level One

Level Two

• Level Three

- Level Four

Level Five

Layouts

Go to the Layout menu on the Home tab to access 
additional page layout options. Cover options are provided 
with tabs in three primary brand colors: orange, yellow, and 
pink. There is also a first page option with placeholders for 
content and author photos provided in the same three 
primary brand colors. Both 1-column and 2-column 
interior pages are provided in the Layout menu. 

Tables

Divider lines: .25pt black

Bottom border: 1pt black

Avoid vertical gridlines when possible.

Highlight key information by shading rows 
and columns with colors from the primary 
brand color palette. 

Helpful hints

10

Theme 3

Diversification 
mirage
Portfolio decisions taken under the 

guise of “diversifying” away from the 

handful of forces driving markets is 

now a bigger active call. Our analysis 

shows that after accounting for 

common drivers of equity returns, 

like value and momentum, an ever 

larger share of U.S. equity returns 

reflects a single, common driver. See 

the chart. Markets are more 

concentrated, with less breadth. 

Attempts to diversify away from the 

U.S. or AI - toward other regions or 

equal-weighted indexes, for example 

– amount to larger active calls than 

before. They have left portfolios less 

exposed to this year’s dominant 

driver of returns – a driver we have 

conviction in. The equal-weighted 

S&P 500 is up just 3% this year 

versus 11% for the market cap-

weighted S&P, LSEG data show. We 

don’t think this can be viewed as 

indiscriminately spreading out bets 

for diversification. They should be 

recognized as big active calls that 

need to be made with conviction. 

Moreover, if the AI theme stumbles, 

the impact will likely dwarf any 

seeming diversification away from it. 

Traditional diversifiers like long-term 

Treasuries do not offer the portfolio 

ballast they once did. That’s why 

investors have been hunting for 

other portfolio hedges – reviving 

interest in gold this year. We see it 

more as a tactical play with distinct 

return drivers and are skeptical of its 

role as a long-term portfolio hedge.

We think diversification means 

shifting away from broad asset 

classes or regional views to more 

granular, nimbler positioning and 

themes that work across scenarios. 

Portfolios need a clear plan B and a 

readiness to pivot quickly. 

We don’t see easy passive 

diversification options in this 

environment. We think investors 

should focus less on spreading risk 

indiscriminately and more on 

owning it more deliberately – in 

short, a more active approach. We 

think high-conviction strategies like 

private markets and hedge funds 

pair diversification with strong 

return potential, in our view. And 

much of their performance is 

idiosyncratic, allowing manager skill 

to show through.

Chart takeaway: Getting inflation all the way back down to 
target – the dotted green line – would require the Fed to deal 
a significant blow to the economy.

A powerful common driver
Variance in S&P 500 returns explained by a dominant underlying factor

Chart takeaway: After controlling for equity style factors, the 
share of daily S&P 500 returns explained by a single factor has 
jumped since last year – a sign of a concentrated market. 

Investment implications 
• Traditional diversifiers like long-dated bonds 

offer less potential portfolio ballast. 

• This environment calls for seeking truly 
idiosyncratic return sources, such as private 
markets and hedge funds, and staying tactical.
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The figure shown relates to past performance. Past performance is not a reliable indicator of current or future 
results. Index performance returns do not reflect any management fees, transaction costs or expenses. Indices 
are unmanaged and one cannot invest directly in an index. Source: BlackRock Investment Institute, with data 
from Bloomberg and Kenneth R. French, December 2025. Note: The line shows the variance of daily S&P 500 
stock returns explained by a common driver after accounting for factors like stock value, size and momentum. 
This was calculated using first principal component (PC1) of a principal component analysis (PCA) over a 
rolling 252-day window. PC1 attempts to determine the common driver in a set of numbers that change often 
– like stock returns for example. 
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The AI buildout in the U.S. faces 

many constraints: political, 

financial as we have noted, but 

especially physical constraints 

involving compute and energy – 

with energy the most binding now. 

AI data centers could use 15-20% 

of current U.S. electricity demand 

by 2030 – a scale sure to test the 

limits of power grid, fossil and 

materials industries. See the chart. 

Some estimates even suggest data 

centers could use a quarter of 

current electricity demand. Rising 

power demand collides with a 

backlog of projects waiting to 

connect with the electric grid and 

generally slow permitting in the 

West. Capex plans could be walked 

back if such limits bite, crimping 

ambition around the AI buildout. 

China stands in contrast, building 

power generation and transmission 

at pace. That includes on-time and 

on-budget nuclear reactors plus 

coal, hydropower and renewables. 

China’s solar and battery 

manufacturing is driving domestic 

solar and battery costs down. 

We believe that gives China a 

number of advantages in deploying 

AI infrastructure: power-intensive 

data centers need cheap, stable and 

clean energy. The focus on 

DeepSeek this year, a seemingly 

more energy-efficient Chinese AI 

model, showed that greatly reducing 

the energy needed for compute 

could partly ease energy constraints.

We see opportunities emerging 

where constraints will likely bite the 

most: power systems, grids, critical 

minerals and potential beneficiaries 

from permitting reform. Private 

capital will be central to bridging the 

gap between the current supply of 

energy and future demand as 

elevated debt limits government 

spending, in our view.

AI buildout faces 
constraints

Mega forces

Chart takeaway: The electricity needs of data centers could 
make up a quarter of current U.S. electricity demand by 2030 — 
with demand-based estimates exceeding those factoring in 
supply constraints. That underscores the scale of the challenge 
and the uncertainty around how the demand will be met.

Investment implications
• Major chokepoints – like power systems and 

the permitting of land – could constrain the AI 
buildout.

• We see private capital playing a critical role in 
financing future energy projects. 

Alastair Bishop
Portfolio manager, 
BlackRock 
Fundamental Equities

Companies haven’t struggled to 

get chips — the real constraint is 

land and energy.”

Forward looking estimates may not come to pass. Source: BlackRock Investment Institute, based on sources 
reviewed by  BloombergNEF, December 2025. Note: Grey bars show the total range, while lines denote the 
median of data center power demand forecasts by method as a share of 2024 U.S. total power demand, 
including traditional data centers and artificial intelligence (AI) data centers and excluding cryptocurrency 
and data transmission networks demand.

Facing constraints
U.S. data center power demand as a share of total, 2024-30
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Estimates

We have entered the third distinct 

world order since World War Two as 

the U.S. fundamentally resets its 

economic and geopolitical 

relationships with the world. 

Transactional trade, industrial 

policy and a resetting of alliances 

to advance a series of U.S. interests 

mark a decisive break from the 

post-Cold War order.

The U.S.-China rivalry is the 

defining feature of geopolitics. 

Competition spans trade, 

technology, energy and defense. AI 

is at the center. Both see AI as the 

key technology determining future 

economic and military advantage 

this century. And both are 

undertaking major efforts to curb 

strategic dependencies that can be 

weaponized. 

Elsewhere, an ongoing war of 

attrition in Ukraine, an uncertain 

peace in Gaza amid structural 

regional change and the largest 

U.S. build-up of forces in the 

Caribbean in decades show how 

regional conflicts and crises can 

layer volatility atop a structurally 

elevated risk environment. 

In Europe, rising U.S. protectionism, 

weak competitiveness and Russia’s 

invasion of Ukraine have restored 

urgency in addressing Europe’s 

challenges, with the EU embracing 

parts of the Draghi report to guide 

policy. NATO allies agreed to target 

defense spending of 5% of GDP by 

2035. See the chart. And Germany 

suspended its “debt brake” to raise 

defense and infrastructure spend. 

Urgency is driving progress in 

energy, where elevated power prices 

and reliance on imports make the 

bloc vulnerable to geopolitical 

shocks. Looser fiscal rules are 

boosting energy investment, and 

new regulation aims to promote 

competition and reduce permitting 

times for clean energy projects.

Fragmentation: 
AI and defense

Mega forces

Chart takeaway: This year’s commitment by NATO allies to 
boost defense spending to 5% as a share of GDP by 2035 follows 
decades of lagging the previous 2% target. We think it highlights 
how deepening geopolitical fragmentation is raising urgency.  

Investment implications
• Hefty defense spending could create medium-

term opportunities in European defense tech. 

• We see the political focus on energy as a 
positive driver for European utilities. 

Tom Donilon
Vice Chairman, 
BlackRock

The U.S. and China AI race will 

define both economic and military 

advantage this century.” 

Forward looking estimates may not come to pass. Source: BlackRock Investment Institute, NATO, World Bank 
and European Commission, July 2025. Note: The solid lines show defense spending as a share of GDP for 
Germany and European NATO countries. The dotted line estimates assume current plans to boost defense 
spending are realized. 

Europe steps up spending
Defense spending, 1960-2027

Previous 2% target

0%

1%

2%

3%

4%

5%

1960 1980 2000 2020

S
h

a
re

 o
f 

G
D

P

Germany NATO-EU

CAPITAL AT RISK. INVESTMENTS CAN RISE OR FALL IN VALUE. FOR PUBLIC DISTRIBUTION IN THE U.S., CANADA, LATIN AMERICA, ​ SELECT COUNTRIES IN EUROPE (SEE THE FULL DISCLAIMER), ISRAEL, SOUTH AFRICA, HONG KONG, 
SINGAPORE AND AUSTRALIA. ​FOR INSTITUTIONAL, PROFESSIONAL, AND QUALIFIED INVESTORS AND CLIENTS IN OTHER PERMITTED COUNTRIES.

BIIM1225U/M-5031110-12/20

https://www.blackrock.com/corporate/insights/blackrock-investment-institute/publications/europe-investment-opportunity
https://www.blackrock.com/corporate/insights/blackrock-investment-institute/publications/europe-investment-opportunity
https://commission.europa.eu/topics/competitiveness/draghi-report_en


Guides

Go to View and check the “Guides” box to see page margins 
and columns. This feature will help align items on the page.  

Text

Adjust text sizes as needed. Bigger is better. Use only 
BLACK or WHITE text. Use font size and/or the Extrabold, 
Bold, or Body font weights instead of color to differentiate.

Body copy (minimum 9pt BLK Fort  

Line Spacing Multiple 1.13

After Spacing 6pt) 

Use Increase List Level tools in text placeholders to adjust 
the text formatting as listed in the reference below:

Level One

Level Two

• Level Three

- Level Four

Level Five

Layouts

Go to the Layout menu on the Home tab to access 
additional page layout options. Cover options are provided 
with tabs in three primary brand colors: orange, yellow, and 
pink. There is also a first page option with placeholders for 
content and author photos provided in the same three 
primary brand colors. Both 1-column and 2-column 
interior pages are provided in the Layout menu. 

Tables

Divider lines: .25pt black

Bottom border: 1pt black

Avoid vertical gridlines when possible.

Highlight key information by shading rows 
and columns with colors from the primary 
brand color palette. 

Helpful hints

13

New asset classes, from crypto to 

private markets, and their broader 

access has implications for core 

aspects of the financial system. 

Take stablecoins – digital tokens 

pegged to a fiat currency, typically 

the U.S. dollar, and backed by 

reserve assets. They are evolving 

from a tool native to crypto to a 

bridge between digital and 

traditional finance. A rising market 

value – now over $250 billion as of 

Nov. 27, per Coingecko – reflects 

wider use across payments, from 

crypto trading and settlement to 

cross-border transfers. See the 

chart. The 2025 Genius Act 

established the first U.S. framework 

for payment stablecoins, placing 

them under regulatory oversight. 

The law bars issuers from paying 

interest but a “marketing-rewards” 

provision enables yield-like 

incentives. That allows competition 

with bank deposits or money 

market funds, which, if it occurred 

at scale, could meaningfully affect 

how banks provide credit to the 

broader economy. The likely extent 

of such shifts is highly uncertain.

What is clearer is that stablecoin 

adoption is widening, including 

integration into mainstream 

payment systems. Beyond banking, 

we see potential for adoption in 

cross-border payments. Additionally, 

in EMs, stablecoins could be used 

domestically as an alternative to 

local currency, broadening dollar 

access but challenging monetary 

control if domestic currency use 

declines, supporting the dollar.

These developments mark a modest 

but meaningful step toward a 

tokenized financial system that is 

evolving rapidly, where digital 

dollars coexist with – and reshape – 

traditional channels of 

intermediation and policy 

transmission.

Future of finance 
evolving quickly

This information is not intended as a recommendation to invest in any particular asset class or strategy or as a 
promise - or even estimate - of future performance. The figures shown relate to past performance. Past 
performance is no guarantee of current or future results. Source: Blackrock Investment Institute, with data 
from Coingecko as of November 27, 2025. Note: The orange line shows the combined market cap of Tether 
(USDT) and USD Coin (USDC), and the yellow line shows their combined market cap relative to the entire 
cryptocurrency market.

Mega forces

The rise of stablecoins
Stablecoin market cap and share of total crypto market, 2020-25

Investment implications
• Stablecoin adoption is widening and is 

increasingly integrated into mainstream 
payment systems.

• These developments mark a modest but 
meaningful step toward a tokenized financial 
system. 

Samara Cohen
Global Head of Market 
Development, 
BlackRock

Stablecoins are no longer niche 

— they’re becoming the bridge 

between traditional finance and 

digital liquidity. ” 

Chart takeaway: Stablecoins have become a structural part of 
digital finance — their market cap has surged to record highs even 
as crypto prices fluctuated, underscoring their growing role as the 
system’s primary source of dollar liquidity and on-chain stability.
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Private credit has entered a more 

uneven phase after years of rapid 

growth. Larger, established lenders 

remain resilient, while some 

smaller and newer entrants are 

under pressure. Competition and 

abundant capital amid lower 

buyout and deal activity has 

compressed spreads and led 

some lenders to compromise on 

credit standards. 

While pockets of stress are evident, 

we think they are concentrated, not 

contagious. See the chart. 

Covenant defaults among smaller 

borrowers have risen more than 

among larger ones — an indication 

of growing dispersion in private 

credit. We also expect dispersion 

by industry, with businesses 

heavily exposed to the consumer or 

threatened by AI most at risk. 

We see defaults as more 

pronounced in a challenging 

economic environment. Losses will 

rise in tandem as poorly structured 

deals unwind, in our view — a 

normal and necessary correction 

after a long benign cycle. 

Reported data may mask stress 

through restructurings or payments-

in-kind, but we think a shakeout will 

distinguish disciplined lenders from 

others. That now makes manager 

selection, due diligence, workout 

capabilities and track records even 

more crucial. We think that gives 

established lenders with strong 

documentation and proven expertise 

an edge. 

Retail flows into semi-liquid private 

credit products are likely to be pro-

cyclical and may amplify volatility 

during periods of stress. Wider 

dispersion creates more alpha 

opportunities and highlights why 

investment skill is key.

Private credit 
enters new phase

The figures shown relate to past performance. Past performance is not a reliable indicator of current or future 
results. Source: BlackRock Investment Institute, Lincoln International, November 2025. Note: The bars show 
the size-weighted covenant default rates by revenue. The dataset excludes companies with negative debt. The 
2024 and 2025 data are for Q2 in both years. 

Mega forces

Dispersion in defaults
Covenant default rates by revenues, 2024-25

Chart takeaway: Covenant default rates among smaller 
borrowers are much higher compared with larger counterparts. 
We think that illustrates the widening dispersion within private 
credit – creating potential alpha for skilled investors.   

Investment implications
• The gap between established lenders and 

newer entrants is growing.

• We think manager selection, due diligence and 
track records are critical for capturing 
potential alpha. 

Vikas Keswani
Managing Director at 
HPS, a part of 
BlackRock

Expect greater dispersion in 

private credit, heightening the 

importance of manager 

selection.” 
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Infrastructure sits at the 

intersection of structural demand 

and a timely market opportunity, in 

our view. We define infrastructure 

as exposure to essential, long-lived 

real assets — transport, energy, 

digital and utility systems — whose 

cash flows are often regulated or 

contracted, giving them “defensive” 

characteristics. 

The AI buildout adds another 

dimension: as we’ve discussed 

earlier, we believe there will be clear 

winners, yet we don’t know who will 

capture the ultimate revenues. In 

any case, we see infrastructure as 

indispensable, providing the power, 

data networks and connectivity 

that the eventual winners rely on. 

We think valuations don’t reflect 

the long-term potential. Listed 

infrastructure trades at a deep 

discount to public equities - below 

global financial crisis levels and 

comparable to the Covid-19 shock. 

See the chart. This discount partly 

reflects uncertainty about the 

outlook for interest rates rather 

than deteriorating fundamentals, 

in our view. 

For long-term investors able to 

accept higher illiquidity, we also see 

attractive opportunities in private 

infrastructure that gives investors 

the ability to directly control assets. 

Private infrastructure also offers 

exposure to certain types of 

infrastructure typically harder to find 

in public markets such as carbon 

capture and storage or biofuels.

For investors with income or 

liability-matching goals, we believe 

both investment grade and sub-

investment grade infrastructure debt 

offer appeal. High yield 

infrastructure debt offers relatively 

attractive spreads and investment 

grade debt can offer insurers capital 

efficiency. Both can offer partial 

inflation linkage. 

Infrastructure: 
a timely moment  

Mega forces

Chart takeaway: Market pricing does not reflect the opportunity  
in infrastructure from mega forces driving multi-decade 
investment needs, creating an attractive entry point.

Investment implications
• Valuations don’t fully reflect the infrastructure 

opportunity – underpinned by mega forces 
driving multi-decade investment needs.

• We think institutional investors can up 
infrastructure allocations across public and 
private markets.

Scott Pearl
Managing Director at 
GIP, a part of 
BlackRock

The infrastructure for AI is a 

permanent trend, and the race 

now is to secure the land, water, 

and power to build it.” 

A valuation discount
Listed infrastructure vs. MSCI World valuations, 2010-25

The figures shown relate to past performance. Past performance is not a guarantee of current or future results. 
Index performance returns do not reflect any management fees, transaction costs or expenses. Indices are 
unmanaged and one cannot invest directly in an index. Source: BlackRock Investment Institute, with data from 
FTSE, MSCI, December 2025. Notes: The chart shows the relative difference between the EV/EBITDA ratio of 
the FTSE World Core Infrastructure 50/50 index and MSCI World indices. The orange dotted line shows the 
average, the shaded yellow area show the range of 1 standard deviation from the average and the green 
dashed lines show the range of 2 standard deviations from the average. 
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Emerging markets have had a 

strong 2025. Local-currency EM 

bonds led gains as inflation fell, 

central banks cut rates and EM 

currencies strengthened against a 

softer U.S. dollar. In our view, that 

phase is ending as much of the 

early policy easing and currency 

strength is now reflected in returns.

We now see opportunities in hard-

currency EM debt and turn 

overweight. A weaker dollar, lower 

U.S. rates and prudent fiscal and 

monetary policy have improved EM 

credit fundamentals, reflected by a 

slew of sovereign rating upgrades. 

Spreads are near decade lows 

across regions, supported by 

limited issuance and stronger 

balance sheets. We favor high-yield 

EM issuers leading sovereign 

ratings upgrades this year – see 

chart. We see these upgrades as a 

sign of improving credit quality 

that alongside attractive carry 

underpins our overweight. We 

prefer bonds to equities across EM 

on a tactical horizon on steadier 

income potential and valuations 

that better reflect near-term risks.

We stay neutral broad EM equities 

on a tactical horizon as mega forces 

drive opportunities and we don’t see 

a clear direction for the U.S. dollar. 

We favor selective exposure to tech 

and themes linked to AI and the 

energy transition across EM and 

China. The rewiring of supply chains 

is benefiting countries like Mexico, 

Brazil and Vietnam, in our view.

In our strategic investment views of 

five years and beyond, a preference 

for above-benchmark allocations to 

Indian equities drives a broader 

overweight to EM equities. India’s 

young and expanding workforce, 

rapid digitization and resilience in a 

fragmented geopolitical landscape 

bolster its long-term growth 

prospects, we think.

Room to run for 
EMs

The figures shown relate to past performance. Past performance is not a guarantee of current or future results. 
Source: BlackRock Investment Institute, Morgan Stanley Research, Standard & Poor’s, Moody’s Investors 
Service and Fitch Ratings, with data from Bloomberg, December 2025. Note: The bars show the net upgrades 
(number of upgrades minus the number of downgrades) made by S&P, Moody’s and Fitch of emerging 
market sovereign debt across different credit ratings. 

Focus –  Emerging markets

Jump in quality
Rating upgrades to emerging market (EM) sovereign debt, 2010-2025

Chart takeaway: Higher-yielding emerging market bonds are 
driving most of this year’s ratings upgrades. We think it highlights 
a rising quality in EM bonds – that are already attractive as high-
income opportunities, in our view. 

Investment implications
• We like EM hard currency debt tactically given 

attractive income, limited issuance and 
stronger sovereign balance sheets.

• On a long-term horizon, we favor EM equities 
at the cross current of mega forces, like India.

Pablo Goldberg
Head of Research and 
Portfolio Manager, 
Emerging Market 
Debt Team, BlackRock

The average EM is more 

resilient, better managed and 

looking more like part of the 

core.” 
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Views

We stay overweight U.S. stocks on the broadening AI 

theme, with risk appetite supported by Fed rate cuts. 

The AI theme has broadened out this year, benefiting 

a wider array of markets including China, Taiwan and 

South Korea. Europe’s lagging earnings growth 

relative to the U.S. keeps us neutral its stocks, but we 

prefer sectors such as financials and industrials. 

Japanese stocks are one of our preferred tactical and 

strategic exposures. Solid economic growth and 

shareholder-friendly reforms underpin our 

overweight. We’re underweight Japanese government 

bonds – and DM long-dated bonds broadly. We prefer 

EM hard-currency debt on attractive carry, limited 

issuance and healthy sovereign balance sheets. 

We think India offers one of the most compelling 

opportunities across emerging markets for long-term 

investors looking to tap into mega forces. We favor 

above-benchmark allocations to Indian equities 

within strategic portfolios with investment horizons of 

five years and beyond. Demographics are India’s 

greatest long-term strength, in our view: a large and 

expanding working-age population, unlike many 

major economies, bode well for sustained gains in 

productivity and consumption, we think. We also see 

it as a potential beneficiary of heightened geopolitical 

fragmentation that benefits multi-aligned and 

connector countries. 

Going 
global   

Tactical Reasons

Still favor AI

• We see the AI theme supported by strong earnings, resilient profit margins 

and healthy balance sheets at large listed tech companies. Continued Fed 

easing into 2026 and reduced policy uncertainty underpin our overweight 

to U.S. equities.

Select international 
exposures

• We like Japanese equities on strong nominal growth and corporate 

governance reforms. We stay selective in European equities, favoring 

financials, utilities and healthcare. In fixed income, we prefer EM due to 

improved economic resilience and disciplined fiscal and monetary policy.

Evolving diversifiers

• We suggest looking for a “plan B” portfolio hedge as long-dated U.S. 

Treasuries no longer provide portfolio ballast – and to mind potential 

sentiment shifts. We like gold as a tactical play with idiosyncratic drivers 

but don’t see it as a long-term portfolio hedge. 

Big calls

Strategic Reasons

Portfolio construction

• We favor a scenario-based approach as we learn more about AI winners and 

losers. We lean on private markets and hedge funds for idiosyncratic return 

and to anchor portfolios in mega forces. 

Infrastructure equity and 
private credit

• We find infrastructure equity valuations attractive and mega forces 

underpinning structural demand. We still like private credit but see 

dispersion ahead – highlighting the importance of manager selection.

Beyond market cap 
benchmarks

• We get granular in public markets. We favor DM government bonds outside 

the U.S. Within equities, we favor EM over DM yet get selective in both. In 

EM, we like India which sits at the intersection of mega forces. In DM, we 

like Japan as mild inflation and corporate reforms brighten the outlook.

Note: Views are from a U.S. dollar perspective, December 2025. This material represents an assessment of the market environment at a specific time and is not intended 

to be a forecast of future events or a guarantee of future results. This information should not be relied upon by the reader as research or investment advice regarding any 

particular funds, strategy or security. 

Our highest conviction views on six- to 12-month (tactical) and over five-year (strategic) horizons, Dec. 2025
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Equities View Commentary

United States

We are overweight. Strong corporate 
earnings, driven in part by the AI theme, are 
supported by a favorable macro backdrop: 
continued Federal Reserve easing, broad 
economic optimism and less policy 
uncertainty, particularly on the trade front.

Europe

We are neutral. We would need to see more 
business-friendly policy and deeper capital 
markets for recent outperformance to 
continue and to justify a broad overweight. 
We stay selective, favoring financials, 
utilities and healthcare. 

UK
We are neutral. Valuations remain attractive 
relative to the U.S., but we see few near-term 
catalysts to trigger a shift.

Japan

We are overweight. Strong nominal GDP, 
healthy corporate capex and governance 
reforms – such as the decline of cross-
shareholdings – all support equities. 

Emerging 
markets

We are neutral. Economic resilience has 
improved, yet selectivity is key. We see 
opportunities across EM linked to AI and the 
energy transition and see the rewiring of 
supply chains benefiting countries like 
Mexico, Brazil and Vietnam. 

China

We are neutral. Trade relations with the U.S. 
have steadied, but property stress and an 
aging population still constrain the macro 
outlook. Relatively resilient activity limits 
near-term policy urgency. We like sectors like 
AI, automation and power generation. We still 
favor China tech within our neutral view.

Tactical granular views
Six- to 12-month tactical views on selected assets vs. broad global asset classes by level of conviction, December 2025

Past performance is not a reliable indicator of current or future results. It is not possible to invest directly in an index. Note: Views 
are from a U.S. dollar perspective. This material represents an assessment of the market environment at a specific time and is 
not intended to be a forecast or guarantee of future results. This information should not be relied upon as investment advice 
regarding any particular fund, strategy or security. 

Fixed 
income

View Commentary

Short U.S. 
Treasuries

We are neutral. We see other assets offering more compelling 
returns as short-end yields have fallen alongside the U.S. 
policy rate. 

Long U.S. 
Treasuries

We are underweight. We see high debt servicing costs and  
price-sensitive domestic buyers pushing up on term 
premium. Yet we see risks to this view: lower inflation and 
better tax revenues could push down yields near term. 

Global 
inflation -
linked bonds

We are neutral. We think inflation will settle above pre-
pandemic levels, but markets may not price this in the near-
term as growth cools. 

Euro area govt 
bonds

We are neutral. We agree with market forecasts of ECB policy 
and think current prices largely reflect increased German 
bond issuance to finance its fiscal stimulus package.  We 
prefer government bonds outside Germany. 

UK gilts
We are neutral. The recent budget aims to shore up market 
confidence through fiscal consolidation. But deferred 
borrowing cuts could bring back gilt market volatility. 

Japanese govt 
bonds

We are underweight. Rate hikes, higher global term premium 
and heavy bond issuance will likely drive yields up further. 

China govt 
bonds

We are neutral. China bonds offer stability and diversification 
but developed market yields are higher and investor 
sentiment shifting towards equities limits upside. 

U.S. agency 
MBS

We are overweight. Agency MBS offer higher income than 
Treasuries with similar risk and may offer more 
diversification amid fiscal and inflationary pressures.

Short-term
IG credit

We are neutral. Corporate strength means spreads are low, 
but they could widen if issuance increases and investors 
rotate into U.S. Treasuries as the Fed cuts. 

Long-term 
IG credit

We are underweight. We prefer short-term bonds less 
exposed to interest rate risk over long-term bonds. 

Global 
high yield

We are neutral. High yield offers more attractive carry in an 
environment where growth is holding up – but we think 
dispersion between higher and weaker issuers will increase. 

Asia 
credit

We are neutral. Overall yields are attractive and 
fundamentals are solid, but spreads are tight. 

EM hard 
currency

We are overweight. A weaker U.S. dollar, lower U.S. rates and 
effective EM fiscal and monetary policy have improved 
economic resilience. We prefer high yield bonds. 

EM local 
currency

We are neutral. A weaker U.S. dollar has boosted local 
currency EM debt, but it’s unclear if this weakening will 
persist.

Underweight Neutral Overweight  Previous view
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Guides

Go to View and check the “Guides” box to see page margins 
and columns. This feature will help align items on the page.  

Text

Adjust text sizes as needed. Bigger is better. Use only 
BLACK or WHITE text. Use font size and/or the Extrabold, 
Bold, or Body font weights instead of color to differentiate.

Body copy (minimum 9pt BLK Fort  

Line Spacing Multiple 1.13

After Spacing 6pt) 

Use Increase List Level tools in text placeholders to adjust 
the text formatting as listed in the reference below:

Level One

Level Two

• Level Three

- Level Four

Level Five

Layouts

Go to the Layout menu on the Home tab to access 
additional page layout options. Cover options are provided 
with tabs in three primary brand colors: orange, yellow, and 
pink. There is also a first page option with placeholders for 
content and author photos provided in the same three 
primary brand colors. Both 1-column and 2-column 
interior pages are provided in the Layout menu. 

Tables

Divider lines: .25pt black

Bottom border: 1pt black

Avoid vertical gridlines when possible.

Highlight key information by shading rows 
and columns with colors from the primary 
brand color palette. 

Helpful hints

BlackRock Investment Institute
The BlackRock Investment Institute (BII) leverages the firm’s expertise and generates proprietary research to provide insights on macroeconomics, sustainable 

investing, geopolitics and portfolio construction to help Blackrock’s portfolio managers and clients navigate financial markets. BII offers strategic and tactical market 

views, publications and digital tools that are underpinned by proprietary research.

©2025 BlackRock, Inc. All Rights Reserved. BLACKROCK is a trademark of BlackRock, Inc., or its subsidiaries in the United States and elsewhere. All other trademarks are those of their respective owners.
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